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Abstract
Advanced computer simulations will play a more and more important role in
future aircraft development and aeronautic research. Hardware-in-the-loop
simulations enable examination of single components without the need of
a full-scale model of the system. This project investigates the possibility
of conducting hardware-in-the-loop simulations using a hydraulic test rig
utilizing modern computer equipment. Controllers and models have been
built in Simulink and Hopsan. Most hydraulic and mechanical components
used in Hopsan have also been translated from Fortran to C and compiled
into shared libraries (.dll). This provides an easy way of importing Hopsan
models in LabVIEW, which is used to control the test rig. The results have
been compared between Hopsan and LabVIEW, and no major differences
in the results could be found. Importing Hopsan components to LabVIEW
can potentially enable powerful features not available in Hopsan, such as
hardware-in-the-loop simulations, multi-core processing and advanced plotting tools. It does however require fast computer systems to achieve realtime speed. The results of this project can provide interesting starting points
in the development of the next generation of Hopsan.
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Nomenclature
Abbreviations
HWiL
Hardware-in-the-Loop
AC
Aircraft Control
LS
Load Simulation
DV
Directional Valve
Denotations
Ap,e
AC Elevator Cylinders Piston Area
Ap,e,L
LS Elevator Cylinders Piston Area
Ap,r
AC Rudder Cylinders Piston Area
Ap,r,L
LS Rudder Cylinder Piston Area
Bp,e
AC Elevator Cylinders Viscous Damping
Bp,e,L
LS Elevator Cylinders Viscous Damping
Bp,r
AC Rudder Cylinders Viscous Damping
Cip,e
AC Elevator Cylinders Internal Leakage Coeff.
Cip,r
AC Rudder Cylinders Internal Leakage Coeff.
Cip,r,L
LS Rudder Cylinder Internal Leakage Coeff.
Cq
AC DV Flow Gain
Cq,L
LS DV Flow Gain
Dv
AC DV Slide Diameter
Dv,L
LS DV Slide Diameter
Je
Elevator Moment of Inertia of Elevator
Jr
Moment of Inertia of Rudder
K
AC DV Orifice to Circumference Ratio
Kce,L
LS DV Effective Pressure-to-Flow Coefficient
Ki,L
LS Integrating Gain
Kp
AC Proportional Gain
Kp,L
LS Proportional Gain
LA,e
LA from Elevator Axis to Airplane Cylinders
LA,r
LA from Rudder Axis to Airplane Cylinders
LL,e
LA from Elevator Axis to Load Cylinders
LL,r
LA from Rudder Axis to Load Cylinder
LM,e
LA from Elevator Axis to Center of Mass
Me
Mass of Elevator
Mr
Mass of Rudder
pl0
AC Work Point System Pressure
pl0,L
LS Work Point System Pressure
ps
AC Maximum System Pressure
ps,L
LS Maximum System Pressure
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[m2 ]
[m2 ]
[m2 ]
[m2 ]
[Ns/m]
[Ns/m]
[Ns/m]
[m3 /sPa]
[m3 /sPa]
[m3 /sPa]
[m3 /Vs]
[m3 /Vs]
[m]
[m]
[kgm2 ]
[kgm2 ]
[%]
[m3 /sPa]
[Vs/m]
[V/m]
[V/m]
[m]
[m]
[m]
[m]
[m]
[kg]
[kg]
[bar]
[bar]
[bar]
[bar]

Sp,e
Sp,r
Sp,r,L
Sv
Vt,L
w
wL
xv,0,e
xv,0,r
xv,max,e
xv,max,r
βe
βe,L
ρ
ρL
ω1
ω2
ω3
ωv,L

AC Elevator Cylinders Maximum Stroke
AC Rudder Cylinders Maximum Stroke
LS Rudder Cylinder Maximum Stroke
AC DV Saturation
LS Elevator Cylinders Oil Volume
AC DV Area Gradient
LS DV Area Gradient
AC DV Working Point Spool Stroke (elevators)
AC DV Working Point Spool Stroke (rudder)
AC DV Maximum Spool Stroke (elevators)
AC DV Maximum Spool Stroke (rudder)
AC System Oil Bulk Modulus
LS System Oil Bulk Modulus
AC System Oil Density
LS System Oil Density
AC Filter Cutoff Frequency
AC System Cutoff Frequency
AC Valve Cutoff Frequency
LS DV Bandwidth
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[m]
[m]
[m]
[?]
[m3 ]
[m]
[m]
[m]
[m]
[m]
[m]
[Pa]
[Pa]
[kg/m2 ]
[kg/m2 ]
[Hz]
[Hz]
[Hz]
[Hz]

1

Introduction

The future aircraft market will put higher demands on more advanced and
complex systems, but also on faster and more cost efficient development.
In order to achieve this, advanced simulation tools will play a significant, if
not to say crucial, role. This thesis work deals with the possibility of using
an already existing hydraulic test rig in future aeronautic development and
research.

1.1

Purpose

The purpose of this thesis work is to investigate the possibilities of using a
hydraulic aircraft test rig for hardware-in-the-loop simulations in aeronautics research. The primary focus is on how to make use of modern computer
systems for this purpose in the most satisfactory way. Software and hardware must be chosen and investigated. One of the most important demands
is the possibility of importing already existing models and controllers. The
results are supposed to be examined by comparing the hardware-in-the-loop
simulation results with a conventional computer simulation.

1.2

Background

The demand for this project emerged from a large international research initiative from 59 European aeronautics organizations called Crescendo, meaning ”Collaborative & Robust Engineering using Simulation Capability Enabling Next Design Optimization”. The purpose of this project is to facilitate for European aircraft manufacturers to develop complex systems
in more cost effective ways and with shorter lead times, by using more advanced and thoroughgoing simulation systems. The test rig in the university
laboratory has the potential to become a powerful tool in this context.
Saab Aerospace ceased production of the Saab 2000 in 1999. Parts of
the hardware-in-the-loop test rig (called Ironbird ), namely the tail control
surfaces and their actuators, were then donated to LiTH from Saab in 2000.
In a student project in 2001 the aircraft hydraulics and the load hydraulics
were mathematically decoupled by a computer based control system, to
avoid undesirable interference between the rudder control and the simulated
external load forces. This feature has not been confirmed by practical testings in a satisfactory way, due to defects in the hydraulic supply system.
(Avellan-Hultman et al., 2001)
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Figure 1: The Ironbird testrig was donated to LiTH from Saab in 2000.
A hardware-in-the-loop simulation (HWiL) is a real-time simulation method.
It differs from conventional computer simulations in the way that one or
more of the components in the simulated system are represented by physical hardware. These components are fed with simulated signals from the
computer model so that they are made to ”believe” that they are part of a
real physical system. This facilitates cheaper and more practicable testings
than a full-size test model, while it still provides more accurate and realistic
results than a regular computer simulation. A HWiL simulation also makes
it possible to conduct experiments beyond the physical limitations of the
original hardware in the system. Another benefit is that when developing
new complex systems, one can construct and examine smaller parts without
having to wait for a full-scale prototype of the system. There is also large
amount of money to save, since a jet engine for example may cost millions of
dollars. HWiL simulations have become a more and more common method
in scientific and industrial development as the systems have become more
expensive and complex. (Gomez, 2001)
In this test rig, the hardware components consist of the aircraft hydraulic
system, the load hydraulic system and the rudder (and elevators), see figure
2.
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Figure 2: A hardware-in-the-loop simulation contains both software and
hardware components.
There is a lack of satisfactory computer environments for dynamic HWiL
simulations of fluid systems. Although good software solutions exist for simulating hydraulic components (such as Hopsan), modelling advanced control
systems (such as Matlab/Simulink) and controlling physical equipment (such
as LabVIEW), these programs often lack convenient methods to communicate with each other. This problem is further complicated when it comes to
performing real-time simulations with a target computer. Finding a general
and satisfactory solution to this is therefore of great interest, even beyond
the main focus of this project.

1.3

Delimitations

Due to lack of time and reconstruction issues, no physical experiments have
been conducted. The resulting documentation and programming solutions
from this project should however make this a both practicable and interesting continuation in the future.
The test rig does only contain the tail parts of the aircraft. This means
that it lacks the ability of simulating for example the ailerons (control surfaces on the wings) and the landing gear. Much of the information in this
report can however be of great use even for other, more complex, test rigs.
This applies especially for the descriptions and solutions of software and
11

programming issues.
In a real flight situation the pitch and roll of the aircraft will affect the
influence of gravity on the elevators and the rudder. Gravitational forces are
included in the models of this project, but are assumed to have a constant
angle relative to the aircraft. The lever arms vary with the angle of the
respective control surface, but not with the pitch or roll of the aircraft. The
rudder is thereby assumed not to be affected by gravity at all. The reason
for this is that the test rig is fixed to the floor and unable to simulate pitch
and roll. Because the computer simulation is to be compared with the HWiL
simulation, it is desirable to include these limitations there as well.
Although many good software environments exist on the markets, it
would be too time consuming to investigate them all. The primary focus of
the programming part of this project has been to translate Hopsan models
so that they can be imported in LabVIEW, and to some extent to investigate
the possibility of importing Simulink models in LabVIEW.

12

2

System Description

The Ironbird in the university laboratory simulates the tail parts of the Saab
2000 turboprop airplane. The tail consists of two horizontal stabilizers and
one vertical. Each of these has the ability to control the airflow, and thereby
the movement of the airplane. This is achieved by adjusting the angle of a
control surface at the end of the stabilizer. These are called elevators for
the horizontal stabilizers and rudder for the vertical one, see figure 3.

Figure 3: Tail parts of a Saab 2000 belonging to Darwin Air at Lugano
Airport. Photo: http://picasaweb.google.com/hdworldmedia
The orientations of an aircraft can be described by three axes of rotation;
pitch, yaw and roll, see figure 4. Elevators are used to adjust the pitch of
the airplane, while the rudder is used to adjust the yaw. On a real airplane
there is also control surfaces on the wings called ailerons, which are used to
control the roll of the airplane. These are however not included in the test
rig, and are therefore of no interest in this project.
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Figure 4: The orientation of an aircraft can be described by pitch, roll and
yaw. Image: http://quest.arc.nasa.gov
The movement of the control surfaces is induced by hydraulic cylinders. In
real flight situations they are also subjected to external air forces. These are
simulated in the laboratory by a separate load simulation hydraulic system.
Both of these systems can be controlled and analyzed from a computer with
the LabVIEW software, see section 2.7.3.
Three hydraulic cylinders are attached to each control surface; two for
aircraft control and one for simulation of air forces. See figure 5.

Figure 5: The elevator is controlled by two aircraft cylinders while the air
forces are simulated by one external cylinder. The springs represent the
stiffness of the structure.
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2.1

Hydraulic Supply System

One of the most crucial aspects in airborne systems is redundancy. During flight, even minor complications can have devastating consequences and
must be avoided at all costs. For this reason, the Saab 2000 aircraft contains
three separate hydraulic systems. If two of these should fail, the pilot can
still maneuver the airplane with the third. Each of these systems are also
supplied by two pumps, one motor-driven and one electric-driven. Each of
these pumps can supply the system regardless of the second one. Only two
of these systems affect the tail part, i.e. the rudder and the elevators, of
the airplane. These are included in the Ironbird test rig. Redundancy is
obviously less important in a laboratory environment. To reduce cost and
space requirements, each system is only supplied by one single pump. These
are driven by hydraulic motors from the same pump system as the load hydraulics. The aircraft pumps are of in-line type with nine pistons and have
variable displacement with constant pressure feedback. Each of these systems also contains an accumulator. The main purpose of these is to reduce
pressure peaks and pulsations, but they shall also provide reserve power for
a short period of time if the pump should stop working. (Andersson and
Herres, 1997)
The load simulation system is supplied by its own hydraulic supply system, similar to the ones used for the airplane actuators. In order to achieve
satisfactory results and avoid interference during the hardware-in-the-loop
simulation, the bandwidth of the load simulation system must be at least
ten times higher than that of the airplane system (Avellan-Hultman et al.,
2001).

2.2

Aircraft Control Hydraulic System

The elevators and the rudder are controlled by two parallel cylinders each,
with separate hydraulic systems. The reason for this is to increase the redundancy of the system. If one cylinder or supply system should fail, the
piston is feathered from the system. This means that the bottom chamber
and the piston rod side chamber in the cylinder will be connected to each
other, so that the pressure difference is eliminated. No force will then prevent the piston from moving in either direction, meaning it will no longer
affect the system. The control of the rudder or elevator can thus be maintained by the remaining actuators. Should both systems fail there is a third
hydraulic backup system, which is activated in case both of the ordinary
cylinders should lose their control signals. The purpose of this is to return
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the elevator or rudder to its neutral position. This will prevent the rudder
or elevator from flickering after the cylinders have been feathered, facilitating for the pilot to maneuver the airplane with the remaining rudders.
(Avellan-Hultman et al., 2001)
The cylinders are supplied by a constant pressure system. Undesirable
dynamic variations in pressure are reduced by an accumulator and the system is protected from pressure peaks by a relief valve, see figure 6. The
piston movement is controlled by a directional valve and a position feedback loop. The damping of the system is increased by a dynamic pressure
feedback loop.

Figure 6: The airplane hydraulic actuators are supplied by a constant pressure system. The valve is controlled by a simple PID-controller.

2.3

Load Hydraulic System

The external air forces are simulated with a separate hydraulic system. This
consists of one cylinder on each elevator and rudder, all supplied by a common constant pressure hydraulic system. The desired amount of force to
apply with each cylinder is calculated in a computer, and achieved through
a force feedback system with a PI-controller. Dynamic variations in pressure
are reduced by an accumulator and the system is protected from pressure
peaks by a relief valve, see figure 7
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Figure 7: The load simulation hydraulic actuators are supplied by a constant
pressure system. The valve is controlled by a PI-controller.

2.4

Measurement Equipment

The test rig contains equipment for measuring pressure, flow, load forces and
angles. Some of these sensors are used for control purposes in the feedback
systems, while others are only installed for analyzing purposes.
Pressure gauges in the aircraft hydraulic system are connected before and
after the pumps, at the drainage pipe of the pumps, before and after the
servo valves at the rudder and before and after the servo valve at one of the
right elevator cylinders. All of these are manufactured by Paine Electronics.
In the real aircraft there are pressure gauges installed before and after all
of the actuators, where they are used for dynamic pressure feedback. The
reason for this is to provide an increased controlled damping of the control
surfaces.
Flow meters are used to measure the leakage flow from one of the aircraft
pumps and the return flow from one of the left elevator cylinders. These do
not play any role in the control system, but are only intended to provide
data for analyzing purposes.
Load forces are measured by load cells installed on the load cylinder
piston rods at all control surfaces. All of them are nickel plated S-type
load cells, and they are capable of measuring large forces in both tension
and compression. They are mainly used as feedback signals for the load
17

simulation servo system.
Angle sensors are installed at all control surfaces. They are capable of
measuring ± 30°and have a scale factor of 125 mV/°. They are used as
feedback signal in the aircraft servo system position feedback loop. See
appendix B for a detailed list of measurement equipment.

2.5

Control System

The aircraft hydraulic system and the load simulation hydraulic system each
have a control system with mainly PID-controllers. Because the movement
of the cylinders in one system will affect the other one, these systems would
be coupled unless additional modifications were introduced.

Figure 8: The control system includes a decoupling link, to make the simulated load forces independent of the airplane hydraulics.
This problem was solved in a previous student project (Avellan-Hultman
et al., 2001). In reality, the aircraft hydraulics will be affected by the load
forces, while the load forces will act independently of the aircraft hydraulics.
For this reason, only the latter needs to be decoupled. The coupling link
(GX in figure 8) can be viewed upon as a flow disturbance acting on the load
hydraulic system. The idea behind the decoupling link (GDC ) is to reduce
or increase the amount of flow equivalently by changing the spool stroke of
the control valve. To avoid measurement disturbances, the decoupling link
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also includes a block for prediction of the rudder angle using the reference
signal.

2.6

Electronic Hardware

The Ironbird can be controlled from a control cabinet, including replicas of
the original Saab 2000 computers. This enables very realistic flight simulations as well as manual control of the control surfaces. Two PC-computers
are also built in, to enable simulation of altitude and velocity. This technology is however very limited and outdated. This project is based on the
premise that this system shall be disconnected, and that modern computers
with hardware and data acquisition tools from National Instruments are to
be used instead. This would not affect the simulation results much, since the
purpose of this project is not limited specifically to the Saab 2000 aircraft.

2.7

Software

This project includes simulation of fluid mechanics, creation of specific mathematical algorithms, translation from different programming languages as
well as control and measurement of physical systems in a laboratory environment. This requires several different computer tools. The most crucial
ones are described in this section.
2.7.1

HOPSAN

HOPSAN is a tool for simulation of hydro mechanical systems. It was first
developed in 1977 at the Department of Mechanical Engineering (IKP) at
Linköping University. It supports co-simulation with Matlab and Simulink,
as well as creation of additional components either manually using Fortran
or through an automated process using Mathematica. Version 1.4, which
has been used in this project, uses the LCC-Win32 compiler.
2.7.2

Mathematica

Mathematica is a C-based computational software tool developed in 1988 by
mathematician Stephen Wolfram, founder of Wolfram Research. Features
include a programming language, libraries of mathematical functions, equation solver algorithms and visualization tools. In this project version 6.0,
developed in 2006, is used.
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2.7.3

LabVIEW

LabVIEW is an abbreviation for Laboratory Virtual Instrumentation Engineering Workbench. It is a visual programming development environment
primarily designed for connecting signals from physical components with
computer software. It is capable of various tasks such as data acquisition,
instrument control, signal processing, embedded design and industrial automation. It is created and marketed by National Instruments, and the
latest version is 8.6.1, released in 2009. Although originally designed for
Macintosh computers, it is now available for most operating systems such
as Windows, Unix and Linux.
2.7.4

Matlab and Simulink

Matlab is a numerical computing software environment with its own interpreted programming language. It is mainly used for technical and scientific
computations. The name is an abbreviation for ”Matrix Laboratory”, referring to the fact that all variables in the program are defined as matrices.
Simulink is a graphic block diagramming tool included in Matlab. It
is capable of creating and solving advanced systems of ordinary differential
equations in the frequency domain by simply connecting a few blocks to
each other. It is tightly integrated with Matlab, and the results can easily
be exported to the Matlab workspace.
2.7.5

Microsoft Visual C++ 2008 Express Edition

Visual C++ is a part of Visual Studio, a commercial integrated development environment engineered by Microsoft. It provides many features for
developing and debugging C and C++ software, but most importantly a
text editor and a compiler. It can be downloaded for free from Microsoft
Developer Network.
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3

Work Progress

The work of this project mainly consists of two parts; describing the test rig
and connecting different software environments. All relevant data possible
to find about the rig has been gathered. This has in turn been used to create
a simulation model. A folder of data sheets has also been put together, to
facilitate future use of the rig. Most Hopsan components have then been
rewritten in C code and imported to LabVIEW. The possibility of importing Simulink models has also been investigated, although not practically
implemented.

3.1

Gathering Knowledge About the System

The primary source for acquiring information about the system and its parameters was to study existing data sheets and hydraulic schemes. Much
data did however show to be difficult to understand, incomplete or even
contradictory. For this reason, an examination of the actual test rig in the
laboratory became necessary. Much information was acquired directly from
the printed text on the components. A last measure was to contact the
manufacturers. In order to facilitate these tasks for future projects, a folder
of data sheets and parameter lists has been created.

3.2

Creating a Simulation Model in HOPSAN

The simulation model was built using HOPSAN. It is principally based upon
a combination of the two systems described in section 2.2 and 2.3. The model
includes three rudder blocks, two supply systems, six aircraft cylinders with
position and dynamic pressure feedback and three load simulation cylinders
with force feedback. Each rudder or elevator is affected by three cylinders;
two for aircraft control and one for load simulation. See appendix D for a
complete hydraulic scheme.

3.3

Building a Rudder Block for HOPSAN

The rudders can physically be described as one-dimensional rotating rigid
bodies affected by three non-conservative forces with lever arms depending
on the angle of the body. This kind of block does for obvious reasons not
exist in the standard HOPSAN libraries. As a consequence of this a special
block had to be created. It has three input signals, one for each actuator
force, and provides angle and angular velocity as output signals, see figure
9.
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Figure 9: A special rudder block had to be created in order to simulate the
system in HOPSAN.
In order to obtain the necessary differential equation describing the movement of the rudder, a free-body-diagram is studied, see figure 10.

Figure 10: A free body diagram of the rudder will give its equation of motion.
Now Euler’s second law with viscous damping finally yields equation 3.1.
X
Ig θ̈ + δ θ̇ =
(Fi Li (θ)) + M gLM (θ)
(3.1)
i = AC1, AC2, LS
The lever arms Li and LM are calculated as functions of θ. See appendix
C for derivations of their respective equations. For definition purposes, the
aircraft cylinder level arms are defined negative and the load cylinder level
arms positive.
The resulting equations were imported into Hopsan through a Mathematica model. To do this, an already existing template for mechanical
components was used. The model could then be compiled using a package
called compgen08.mx. This produces a Fortran file (.f), which in turn can
be imported by Hopsan. The picture for the graphical user interface was
created and imported as a Windows Metafile (.wmf).
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3.4

Exporting Matlab Models to LabVIEW

Simulink models can be imported directly to LabVIEW from a small .dll
file by using the Simulation Interface Toolkit (Nat, 2003b). This is a simple
and reliable, albeit limited and costly, procedure. For instance, the Simulink
model must not contain blocks from certain toolkits, such as SimMechanics.
The required LabVIEW toolkit also has to be purchased separately, and is
rather expensive.
An alternative solution is to export everything from Simulink to one .dllfile, containing the entire model in C-code. This can be quite tricky, but
provides a reliable and much more compatible result. Because the .dll-file
contains everything of interest, it makes the model independent of Matlab
and Simulink and it can be used in practically any advanced simulation
environment. The independence from external software also allows real-time
simulations in a target computer. (Ek, 2006)
A third option, similar to the .dll-method, is to export the model as C
code, and then compile and import this directly into LabVIEW. This allows
manual adjustments of the code after it has been exported. This method and
its requirements are somewhat similar to the ones for HOPSAN mentioned
in section 3.5.

3.5

Exporting HOPSAN Models to LabVIEW

HOPSAN does have some built-in co-simulation abilities, but lacks the capability of exporting a complete model for real-time execution in another
simulation environment. It does however support a way of exporting models
and components to C code. Newer versions of LabVIEW can then import C
code from external sources. This does on the other hand require extensive
changes to the syntax of the code.
3.5.1

Requirements on the Code Syntax

The code must be written in a correct way so that LabVIEW can understand
it. First of all, LabVIEW uses its own variable classes. These are called
intX t, uintX t, float and double. The first two represent signed and
unsigned integers, where X is the size of the variable (8 bit, 16 bit, 32 bit
or 64 bit). The last two represent float numbers of 4 bytes and 8 bytes
respectively. This is solved in the code by including a LabVIEW library
called extcode.h, which translates the types automatically. It is however
worth to have in mind since the function calls from LabVIEW may differ
from the actual functions in the code.
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Many functions in Hopsan require multiple return values. This is not supported by C/C++, but can be achieved by using references to the variables
instead of the actual variables as parameters. This is achieved by putting
an & symbol at the beginning of the parameter. This means a function call
can look like this:

func1 (&* in1 , &* in2 , &* out1 )
...
int func1 (* a , *b , * c )
{
*c = *a + *b;
return 0;
}

This means that all the parameters will be updated according to how they
are affected in the function. In this case the value of *c will be returned
even though the function itself does not return anything useful.
Importing C code to LabVIEW can be achieved in two ways. One can
either use a Code Interface Node (CIN) block, which will include the external code entirely into the model file, or a Call Library Function (CLF) block
which calls an external shared library file (.dll). The first method is more
complicated and outdated, even though it provides some interesting features
such as initialization routines. The .dll method is simpler in general, and
makes it possible to place each component in a different LabVIEW block.
This will make the block diagram more understandable, and can possibly enable multi-core features. When working with CIN blocks LabVIEW always
passes pointers instead of values, meaning all variables must be preceded by
an asterisk (*). This can be chosen arbitrarily for each variable when using
a CLF. (Nat, 2003a)
Both of these methods have been examined in this project.
3.5.2

Translation of Hopsan Libraries to C

Creating a shared library (.dll) requires a programming language suitable
for this, such as C. Hopsan is written in Fortran, which is not suitable. For
this reason its source code had to be translated to C. This was done automatically by a program called F2C. Although this method is much faster
than translating by hand, it does not produce very nice code and requires
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much manual clean-up work. First of all, the exported files are poorly structured. They include calls to several external functions that LabVIEW does
not know of, and most types and classes are renamed to match the Fortran
standard. Furthermore they include poor programming solutions such as
global variables, goto-functions and complete enumerations. These problems were solved by rewriting much of the translated code by hand.
3.5.3

Importing Models to LabVIEW with Code Interface Nodes

For a Code Interface Node block, the C-file to be imported must have the
following basic structure:

/* CIN source file */
# include " extcode . h "
MgErr CINRun ( int32 * Num_in_1 , int32 * Num_in_2 ,
int32 * Num_out_1 , int32 * Num_out_2 )
{
// Place your code here ,
// this is just an example
* Num_out_1 = * Num_in_1 + * Num_in_2 ;
* Num_out_2 = * Num_in_1 * * Num_in_2 ;
return noErr ;
}

On a Windows system, LabVIEW only supports compilation from Microsoft
Visual C++ or Symantec C. In this project Microsoft Visual C++ 2008
Express Edition has been chosen. The code can be compiled directly to
an .lsb (LabVIEW Subroutine) file by using a custom build utility included
in LabVIEW. If no errors occur, this file can then be imported to a Code
Interface Node block in the LabVIEW virtual instrument’s block diagram.
This procedure is explained in detail in appendix E. (Nat, 2003a)
3.5.4

Importing Models to LabVIEW from Shared Libraries

The .dll file is compiled in Microsoft Visual C++, although technically any
other compiler or programming language capable of creating shared libraries
could have been used. The code syntax will look similar to the one used in
the Code Interface Node, but with a more general approach:
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/* Call Library source file */
# include " extcode . h "
_declspec ( dllexport ) long function_name ( double * in1 , double * in2 ,
double * out1 , double * out2 )
{
// Place your code here ,
// this is just an example
* out1 = * in1 + * in2 ;
* out2 = * in1 * * in2 ;
return 0;
}

The expression declspec(dllexport) is a command that tells the compiler
to explicitly export the function from the .dll file, to make it visible from
LabVIEW. For a detailed tutorial on how to import shared libraries, see
appendix F. (Nat, 2003a)
3.5.5

Optimizing the Shared Libraries

At first the same component code was used for the code interface node
method and the shared libraries method. The latter did however prove to
be very memory and CPU inefficient. The code was therefore optimized in
several ways, to reduce waste of computer power. First of all, everything
did not need to be included in every component. All unnecessary code
was removed from each library, so that only the functions and variables
that are actually used by the component are included in its file. Second,
many variables were stored in arrays to allow multiple instances of the same
functions. These have now been reduced so that no array is longer than
what is actually required. The last optimization method was to remove
duplication of variables. This gives a more efficient code, at the cost of
reduced readability and more difficult fault detection.
3.5.6

Setting up the LabVIEW Block Diagram

For the simulation to work it is necessary to provide the simulation time
and the time step to the Hopsan components each iteration. This works the
same way regardless of whether a Code Interface Node or a Call Library
Function block is used. In order to obtain these variables a While Loop
is put around the blocks. This is the gray border in figure 11, showing
the block diagram for a laminar orifice and two prescribed pressures. The
time step can be selected manually by feeding a signal into a Time Delay
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block. The simulation time can then be obtained by multiplying the time
step with the number of iterations, which is provided by the Loop Iteration
block. The time and time step signals must then be fed into each Hopsan
block as well (except the simple ones, such as line terminations). This gives
the numerical algorithms the necessary information in order to carry out
continuous mathematical operations such as integrations and filtering. An
alternative approach could be to only provide the blocks with the time step
and then let each component calculate the time iteratively. This would
allow a cleaner block diagram, at the cost of an additional potential source
of error. Something else to notice in the figure is the stop button, which
is used to reset simulation time to zero. This does not really do anything
useful in this case, but LabVIEW demands it to be there.
An alternative approach to the while loop could be a timed loop. This
would provide a similar result, but offers more advanced options such as
priority settings and manual selection of processors (Ek, 2006).

While Loop

Loop Iteration block

Time Delay block

Figure 11: The Hopsan functions exported to LabVIEW must receive the
simulation time and the time step.
Hopsan uses wave variables and characteristic impedances to describe wave
propagation in a system. Some components will receive the wave variables
and impedances and return pressure and flow (or force and position), while
others will receive pressure and flow (or force and position) and return wave
27

variables and impedances. These components are called Q type and C type,
respectively. In a block diagram, components must always be connected
so that a Q type component is connected to a C type component in each
node. In LabVIEW this will require a feedback loop between the blocks.
The feedback signal will automatically be given a Feedback Node block with
an Initializer Terminal. The function of a Feedback Node is that it will
store the signal value from the last simulation step, so that it can be used
as an input signal at the next step. The Initializer Terminal can be used to
provide a value for the first simulation step, when no value from the previous
step exists. This is however not necessary in most cases. See figure 12.

Figure 12: LabVIEW automatically creates a Feedback Node and an Initializer Terminal once a feedback loop is created.
When working with shared libraries, it is crucial that the function call in
LabVIEW has exactly the same name, number of parameters and data types
as the one in the .dll file. One single wrong symbol may result in a program
crash. The names of the parameters do not matter, but it is obviously most
convenient to choose the correct ones. Using too many parameters will not
crash the simulation either. This is important to have in mind, since an
extra parameter can cause extensive problems without producing any error
messages. It is also important to use different .dll-files for each component,
even if they represent the same type of component. If two components use
the same .dll-file, they will also use the same local variables. This can cause
serious problems, such as division by zero or variables increasing to infinity.
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When restarting a simulation it is necessary to first close and then reload
the model in LabVIEW. Although there is a Reinitialize Values to Default
function, it will not reset the local variables declared in the memory by each
.dll-file. These will keep their final values from the last simulation, possibly
causing errors in the new simulation.

4

Results

The results of this thesis work consist of a folder of data sheets and parameters for the test rig, a computer model of the rudder for Hopsan and
LabVIEW, a Hopsan model of the test rig hydraulic system and translations
of most Hopsan components so that they can be imported by LabVIEW.

4.1

Rudder Block for Hopsan and LabVIEW

The rudder block describes a rudder affected by two cylinders from above
and one cylinder from bellow (see figure 13). Note that only one of the
upper cylinders is drawn in the figure, because they normally have the same
angle of attack. This does however not always need to be the case.

Figure 13: The attachment of a rudder with its actuators. The geometry
can be described by four measurable lengths.
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Constants
The necessary constants consists of the distances a, b, c and d for each
cylinder (see figure). Mass, moment of inertia, torsional spring constant,
viscous damping and lever arm between the attachment and the center of
gravity in the neutral position must also be provided. Finally the minimum
and maximum angle for the rudder as well as minimum and maximum stroke
for each cylinder are also required.
a1,2,3
b1,2,3
c1,2,3
d1,2,3
mL
Ig,L
bL
kL
lg,0
θmin
θmax
xmin,1,2,3
xmax,1,2,3

[m]
[m]
[m]
[m]
[kg]
[N s2 ]
[N ms/rad]
[N m/rad]
[m]
[rad]
[rad]
[m]
[m]

(see figure)
Inertia of rudder
Moment of inertia of rudder
Viscous damping coefficient
Torsional spring coefficient
Lever arm to center of gravity at neutral position
Minimum angle
Maximum angle
Minimum cylinder stroke
Maximum cylinder stroke

Input Parameters
The required input parameters consist of the wave variables and the characteristic impedances for each cylinder.
c1,2,3
zc1,2,3

[m]
[m]

Wave variable
Characteristic impedance

Output Parameters
The rudder block returns the angle and angular velocity, as well as the lever
arms of each cylinder. The resulting force from each cylinder and their
respective positions are also returned.
θ
θ̇
L1,2,3
f1,2,3
x1,2,3
ẋ1,2,3
ẍ1,2,3

[rad]
[rad/s]
[m]
[m]
[m]
[m]
[m]

Rudder angle
Rudder angular velocity
Cylinder lever arms
Resulting force from cylinders
Cylinder position
Cylinder speed
Cylinder acceleration
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4.2

Translated Code Structure

The code was at first translated with the idea of importing complete models
using Code Interface Nodes in mind. For this purpose the entire simulation
system was translated, although somewhat simplified.
The resulting translation of the Hopsan source code has a similar structure as the original code to a certain degree, but has also been modified at
certain points to be more flexible and to make the functions more independent of each other. The Fortran code uses global variables and functions to
a great extent. This has now been changed so that each function is aware
only of its input signals, output signals and local variables. Another change
is that the nodes are now represented by a node class which is common
for all node types. The node class is a structure containing a type variable
which determines its type (hydraulic, mechanical, rotational etcetera) and a
node number variable. The variables of the node are then arranged in separated substructures. Which one of these to use is decided by the contents
of the type variable. Another introduced variable is Sim stat. This is a
structure where all information about the status of the simulation is stored,
for example initialization state, time step and error control. See figure 14.

Figure 14: The nodes are stored in node type structures, and the simulation
status in a sim stat type structure.
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The nodes are stored in an array and new nodes are added to the array by a
function called addNode. The program is then executed by a main function,
which calls subroutines from two libraries: Components and Arithmetics.
These contain all the components used in the simulation. Each component
is assigned a unique component number to differ them from each other.
The component subroutines take the nodes and the Sim stat variable as
both input and output parameters, and its constant parameters as input
values. The arithmetic functions works in a similar way, but do not affect the
nodes or the simulation status. These libraries do require some subroutines
themselves, for example numerical algorithms and filters. For this reason a
third Auxiliary Functions library is also included. See figure 15.

Figure 15: The code includes a main function, a component library, a library
of arithmetic functions and a library of auxiliary functions.
The components have been redesign so that all constants are now passed as
parameters from the main routine. This eliminates the use of external data
files, in order to facilitate real time applications. The downside is that the
main routine must keep track of all constants for each component, making
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the file less readable. Each component has been structured in the following
way:
Input Parameters
_
Declaration of Local Variables
_
Declaration of Functions
_
Initialization
_
Equations
_
Output Parameters
The purpose of this is to make the files easy to read and to increase the
coherency of the code.

4.3

Code Structure in Shared Libraries

Each shared library (.dll-file) only includes a minor part of the translated
code. The file is composed by a main routine, practically working as a wrapper function to make the input values from LabVIEW compatible with the
special node and sim stat classes. It also includes a component function and
all auxiliary functions required by the component. All component numbers
have been removed, since only one instance of each component exists in each
library. The hopsan init header file must however still be included in order
for the node and sim stat classes to work, as well as the addNode function.
See figure 16.
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Figure 16: The shared libraries only contains the necessary parts of the
translated code.
A list of all components translated to .dll and the required function calls
and parameters to use in LabVIEW is enclosed in appendix G. At this
point all translated components except two, ”Long Line with Distributed
Parameters” (line.dll ) and ”Long Line with Lumped Parameters” (lline.dll )
work. This means that their basic functionality have been examined and
confirmed in LabVIEW. The line connector functions gcon and tcon have
been translated but not examined, since they are only useful together with
the line components.
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5

Analysis

The resulting codes and models must be analyzed and verified to confirm
their functionality. The rudder block is examined so that it works properly,
although there was no time to confirm these results with a hardware experiment. The code translation from Hopsan to LabVIEW has been analyzed
by comparing the results between equivalent systems in both simulation environments. Finally, the performance of the LabVIEW simulations has been
examined.

5.1

Analysis of the Rudder Block

Two tests were conducted to verify the behavior of the rudder block. Both of
these have been executed in both Hopsan and LabVIEW. First of all it was
necessary to examine the basic functionality of the block in a very simple
system. Three forces act on the rudder, representing the three hydraulic
systems. The two aircraft cylinder forces are controlled by a proportional
position feedback. See figure 17.

Figure 17: The rudder block is controlled and analyzed by three force generators.
The system is simulated for 5 seconds. After 2 seconds a step input signal
tells the rudder to move from -0.5 rad to 0.2 rad. Then after 4 seconds a step
disturbance force is applied. The resulting graphs are shown in figure 18.
As can be seen, the rudder responds in a realistic way. It can also be noted
that no significant differences in the result exists between the simulation
environments.
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(a) Rudder results from Hopsan.

(b) Rudder results from LabVIEW.

Figure 18: The effect on the rudder from a step input and a disturbance
force is simulated in Hopsan and LabVIEW.
The second test aim to examine the behavior of the rudder block when put
into a more complicated hydraulic system. This system is based upon two
pistons controlling the rudder, controlled by one servo valve each. The servo
valves are supplied by two constant pressure pumps. An angular position
feedback with proportional control is used to control the valves, so that
the two systems will always work together and perform the same tasks. A
force generator block is also used to simulate external load forces. See figure
19. In LabVIEW the double pump-valve-piston systems are represented
by one single system, where the force exerted by the piston is duplicated
before it is fed into the rudder block. This dramatically decreases the size
and complexity of the block diagram. Hopsan does however not offer this
convenience.

36

Figure 19: The rudder block is analysed in a system with more advanced
dynamics.
A step input signal and a step disturbance force is simulated. The input
signal will tell the rudder to move from -0.5 rad to 0.2 rad after 1 second.
Then after 2 seconds a disturbance force is introduced. The results are
shown in figure 20. As can be seen, the rudder responds as expected; fast
but with a small overshot and some oscillations. The feedback gain can be
adjusted to remove these, at the cost of a slower response. There are slightly
more oscillations in LabVIEW. The reason for this is most likely numerical
differences, such as time steps or number of samples.
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(a) Rudder results from Hopsan.

(b) Rudder results from LabVIEW.

Figure 20: The rudder block responds in a realistic way in both simulation
environments.

5.2

Comparison Between Hopsan and LabVIEW

There is always a risk of error involved when translating code from one
software environment to another. There is also a risk of problems appearing
after all parts have been put together, even if each translated component
should work correctly. A small error can still make significant damage when
replicated many times in an iteration loop. Finally, the differences in the
simulation environment can also affect the results. For this reason it is
necessary to compare the simulation results from Hopsan with the ones
from the same model in LabVIEW. This has only been done for the shared
library method, because it appears to be the most useful one.
The first examination is a comparison between the results from a system
with a spring and an oscillating mass. A spring coefficient of 100 N/m and
a viscous friction of 20 Ns/m are used, see figure 21. The simulation is run
for 30 seconds. After 5 seconds a disturbance force of 40 N is applied at the
100 kg mass.

Figure 21: An oscillating spring-mass system is analyzed in both LabVIEW
and Hopsan.
The results show that there are no distinguishable differences between the
results. The spring begins to oscillate, is damped by the viscous friction and
approaches a stationary value. No difference can be seen in either amplitude
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or frequency. See figure 22.

(a) An oscillating spring in Hopsan.

(b) An oscillating spring in LabVIEW.

Figure 22: An oscillating spring-mass system was simulated. No distinguishable difference can be seen.
The second comparison involves a more complicated system. A pressure
controlled pump supplies a system with 200 bars. A 4/3 servo valve is used
to control a piston with an inertia load with a mass of 10 kg and a viscous
friction of 20 Ns/m. No external forces affect the system. The piston is
controlled by a position feedback and a proportional controller with a gain
of 0.0008. The stroke of the piston is 1 m. See figure 23. The simulation is
run for 10 seconds. After 5 seconds, a step signal of 0.5 m is applied.

Figure 23: A cylinder with position feedback control in a constant pressure
system is simulated in Hopsan and LabVIEW.
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The result shows that both simulation environments give similar results.
See figure 24. It was however found that using too small time steps in
LabVIEW will decrease the quality of the results significantly. The time
step must be reduced to approximately 0.001 s before its effect on the graph
can be considered negligible.

(a) Step response in Hopsan.

(b) Step response in LabVIEW.

Figure 24: The step response on a piston-mass system gives the same result
in both simulation environments.
As a final test a pressure relief valve was compared between the environments. This is of great interest because the behavior of the valve depends
on time steps and numerical parameters to a great extent. The system is
supplied by a fixed displacement pump, and a two port volume connects the
pump to the valve. See figure 25. The opening pressure of the valve is set
to 100 bars.

Figure 25: A pressure controlled valve is used to limit the system pressure.
The system begins to oscillate slightly about the reference value, and then
evens out at the desired pressure. The oscillations are a result of the valve
dynamics; it can not open nor close infinitely fast. As can be seen, the results
show no apparent differences between the simulations. This was expected,
because the time step and thereby also the number of samples is the same
in both cases.
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(a) System pressure in Hopsan.

(b) System pressure in LabVIEW.

Figure 26: A pressure relief valve limits the pressure to 10 MPa.

5.3

Examination of Simulation Performance

When conducting real-time simulation with hardware and software, it is important that the computer system used to support the software simulation
is fast enough. Otherwise the clock in the software will run slower than the
one for the hardware, producing erroneous results. For this reason the performance of two systems were analyzed. The simulation time was compared
with the actual time elapsed during the simulation. The latter was received
from an Elapsed Time block in LabVIEW. The following system was used
for the experiment:
Windows XP Professional Service Pack 3
AMD Athlon 64 X2 Dual Core Processor 4200+ (2.21 GHz)
1.96 GB of RAM
Inactive input means that the system is running with no change in the input
signal, so that nothing is happening. Active input means that the input signal is constantly changing. Time step are set to 0.01 s for the single piston
system and 0.001 s for the rudder system. Results are as follows:
Single piston with position feedback (inactive input)
Simulation time:
30 s

Actual time:
30.6 s

Single piston with position feedback (active input)
Simulation time:
30 s

Actual time:
31.7 s
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Rudder system with position feedback and disturbance force
Simulation time:
3s

Actual time:
7.4 s

As can be seen, none of the simulations can achieve actual real-time simulations on this system. The rudder simulation takes more than twice as long
time as is simulated.
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6

Discussion

Making different software environment communicate with each other is a
complicated process. The main reason for this is probably that the software
producers do not want the consumers to use other software than their own.
This procedure does however show very satisfactory results, because you can
take advantage of the strengths in both programs or get around possible
weaknesses. Although commercial toolkits for these purposes often already
exist, they are usually limited. They may for example only support a few
selected products or demand both programs to be running simultaneously,
making real time simulations difficult. Furthermore they are often more
expensive than the programs themselves. For this reason there is a lot of
money to save in solving these problems single-handed.
One important phenomenon I noticed when optimizing the shared libraries was the contradiction between readability and efficiency in programming code. A 100% effective code will for example result in long and complicated variable names, making it nearly impossible to find an error in the
code by simply looking at it. A solution to this could be to keep an unoptimized version for error detection purposes. On the other hand, the strength
of modern computers may render total optimization unnecessary. In long
and complicated simulations the capabilities of the computers may on the
contrary still play an important role, especially for real time simulations.
During this project I have learned that many problems are easier to
solve than one may first think. I have come across many difficulties that at
first seemed impossible to solve or even understand, but then the solution
appeared out of nowhere before the afternoon coffee break. The conclusion
of this is to always give the problems the time they need, and to not give
up just because you at first do not know how to do.

6.1

Problems

The performance experiment showed that the LabVIEW models were not
able to produce real-time results on the computer used for this thesis work.
The simpler model was however close and should be able to achieve this on
a more advanced system, especially with a digital signal processor (DSP). It
should also be pointed out that several operating system applications were
running simultaneously. The rudder system was on the other hand far from
its goals, and would likely require a very fast machine to run smoothly.
Further optimization of the code is also possible. One shall also have in
mind that multi-core support was not used in neither of these examinations.
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Three components are still not working properly with the translated code;
the volume with arbitrarily connections, the long line with lumped parameters
and the long line with distributed parameters.
The problem with the volume components is that the current code requires the nodes to be stored in a global array, so that the subroutine can be
told to call arbitrarily many of them. This can be solved by either passing all
nodes to the component routine as input parameters, which would be very
memory inefficient, or by making one volume component for each number of
nodes. The latter of these solutions have been used in this project, although
neither of these solutions could be considered good programming manner.
It is advised to investigate the possibility of passing arbitrarily sized arrays
to a subroutine in C code.
For the line components, the problem is that they are generated externally from Mathematica models. The code is for this reason very difficult to
follow, and error detection is simply not possible. A solution to this could
be to explore the possibility of exporting models from Mathematica to C
code instead of Fortran code. Issues like these are worth to have in mind
when developing a model generator for the next generation of Hopsan.

6.2

Sources of Error

When working with computer models, there are several possible sources of
error affecting the results. First of all, a model is always an approximation
of reality. The accuracy of this approximation will have a major impact on
the quality of the results.
Another risk is numerical errors, resulting from the fact that most mathematical equation systems can not be solved analytically on a computer. This
means numerical algorithms with more or less limited precision have to be
used. One important way to counter this problem is to work with small
simulation time steps. When comparing Hopsan and LabVIEW there did
at first appear to be extensive differences in the results. This phenomenon
did however disappear when reducing the time steps.
Finally, an important issue is the uncertainty in the parameter values.
Much of the required data of the system is not known and has to be approximated. In the Iron Bird this is made worse by the fact that most physical
equipment is quite old, making it difficult to find reliable information and
data sheets of the components. Another problem is the fact that component
characteristics often change over time, making the information unreliable
even if it can be found. This means that many variables can not be known
exactly and must be approximated.
44

An important phenomenon in simulations, especially when simulating longtime scenarios, is the reproduction of errors. An error that may seem insignificantly small at the beginning can still have a great impact in a larger
system or over a long time.
The exact functionality in LabVIEW can be difficult to analyze because
it is integrated in the environment. This is a great advantage with open
source software, where one can have complete control of the simulation methods. One very important observation is however that the simulation time
must be calculated by multiplying the number of performed iterations with
the time step. If done in any other way, it proved to cause numerical errors such that making the time scale wrong or reducing the amplitude in
oscillations even when they are not damped and should maintain constant
amplitude. Needless to say it is also important not to change the time step
in the midst of a simulation.
Another risk to have in mind when examining a simulation model is
that one often choose very nice values to obtain good looking and easyto-understand results. There is then a risk that the model is only correct
for these values, while it would not work very well with less slanted values.
Verification with the help of physical hardware would therefore be a good
way of confirming the results from the examination of the systems.

6.3

Differences Between Hopsan and LabVIEW

There are no major differences in the results in LabVIEW compared with
Hopsan, assuming the same time step is used. This is what was expected,
because the code of the components is principally the same. Hopsan has a
simple and easy user interface, albeit somewhat outdated and limited. In
LabVIEW one must do everything by hand, as a result of the fact that the
environment is not intended for this field of usage. A major strength in
LabVIEW is the possibility of conducting real-time simulations. This opens
up very powerful possibilities, and was also one of the primary intentions
of this project. The greatest advantage of LabVIEW compared to Hopsan
is however the possibility of connecting the software to a hardware model
using PCI-cards. This allows HWiL-simulations, as well as an easy way to
verify the simulated components with reality to improve their performance.
There has unfortunately not been enough time to test the translated models
in other environments than a PC computer with Windows XP, so some
modifications may be necessary for use in a host-target system.
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6.4

Recommendation for Next Version of Hopsan

To maintain compatibility it is strongly recommended to either keep the
component libraries in C code, or to include a simple way of exporting the
component code to C. This would maximize the possibilities of exporting
components and models to other environment (although some modifications
may still be necessary).
When it comes to code structure, it is not advisable to keep the current
system with global variables. A better and more efficient solution would be
to store the nodes in an array in the main routine, and then pass the nodes
only to the components that will need them. A similar system with the
global simulation parameters, for example time step and error codes, would
also be to prefer. Another poor solution used in the Fortran code is goto
commands. These can easily be exchanged with for example switch-case
expressions.
The simulation model must keep track of the components and nodes by
providing them with a number. It is advisable to keep a similar numbering
system as in the previous version. This means that each component routine
will assign the numbers themselves and return the number to the main
routine, to make sure the numbers start at 0, 1, 2... and nothing else.
One problem with the previous version is that the data is stored in fixed
arrays, limiting the maximum number of each component type a model can
have. A solution to this could be to investigate the possibility of using
variable sized arrays, which will be increased automatically if they should
become too short. This would reduce the amount of required memory, and
allow arbitrarily sized systems to be simulated.
A significant improvement would be to improve the graphical user interface, to make the program more user friendly. It is also recommended to
introduce an undo-function, because mistakes easily happen in the current
interface. Another interesting improvement would be an autosave-function,
as the program is not always very stable. The instability issues can also be
countered by introducing some sort of exception handling in the code, to
prevent sudden unexpected program crashes.
The compatibility between Hopsan and LabVIEW should be investigated
further. This can probably more or less be included in the program itself,
for example with an automatic export function for .dll-files. It would also
be interesting to consult representatives from National Instruments for an
exchange of ideas and opinions.
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6.5

Recommendations for Continued Work

The possibility of using the shared libraries (.dll-files) in computer environments suitable for real-time simulations with host-target computers should
be investigated further. Then it is recommended to conduct a test run of a
HWiL simulation with the .dll-files in a simpler physical hydraulic system.
If all of the above works well, a full scale test run of a simulation with the
Ironbird is necessary to finally verify the results.
The rudder block needs to be tested and verified by comparing it with
the behavior of the real physical component.
The multi-core support in LabVIEW would provide interesting opportunities and needs to be investigated further. The possibility of implementing
this in the next version of Hopsan would also be of great interest and should
be examined. The ability of importing and exporting .dll-files to and from
other simulation environments would also be an interesting feature, which
would further increase the compatibility.

6.6

Conclusions

It is possible, although somewhat complicated, to use Hopsan components
in the LabVIEW environment. This enables powerful features such as realtime simulations and advanced plotting tools. It does on the other hand
require powerful computer systems. The possibility of taking advantage of
multi-core support and conducting hardware-in-the-loop simulations should
be investigated further.
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A

List of Parameters

Elevator Control Hydraulic System
System Parameters
Maximum System Pressure
Work Point Pressure
Oil Bulk Modulus
Oil Density
Filter Cutoff Frequency
Cutoff Frequency (noise reduction)
Valve Cutoff Frequency

ps
pl0
βe
ρ
ω1
ω2
ω3

200 bar
20 bar
1.2 GPa
850 kg/m2
10 kHz
10 Hz
500 Hz

Directional Valve
Flow Gain
Slide Diameter
Maximum Spool Stroke (elevators)
Maximum Spool Stroke (rudder)
Working Point Spool Stroke (elevators)
Working Point Spool Stroke (rudder)
Orifice to Circumference Ratio
Saturation
Area Gradient

Cq
Dv
xv,max,e
xv,max,r
xv,0,e
xv,0,r
K
Sv
w

0.67
5 mm
1 mm
0.5 mm
0 mm
xv,max,r
30 %
0.001
K· π· Dv

Control System
Proportional Gain

Kp

0.004

Elevator Cylinders
Internal Leakage Coefficient
Piston Area
Stroke
Viscous Damping (estimated)

Cip,e
Ap,e
Sp,e
Bp,e

1· 10−12
1.2339· 10−3 m2
5 cm
3500 N s/m

Rudder Cylinders
Internal Leakage Coefficient
Piston Area
Stroke
Viscous Damping (estimated)

Cip,r
Ap,r
Sp,r
Bp,r

1· 10−12
1· 10−3 m2
9.8 cm
3500 N s/m
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Load Simulation Hydraulic System
System Parameters
Maximum System Pressure
Work Point Pressure
Oil Bulk Modulus (estimated)
Oil Density (estimated)

ps,L
pl0,L
βe,L
ρL

200 bar
20 bar
1 GPa
860 kg/m2

Directional Valve
Flow Gain
Flow-Pressure Coefficient
Slide Diameter
Area Gradient
Bandwidth

Cq,L
Kce,L
Dv,L
wL
ωv,L

0.67
4· 10−11
1 cm
π· Dv,L
700 Hz

Control System
Proportional Gain
Integrating Gain

Kp,L
Ki,L

1· 10−6
1· 10−6

Elevator Cylinders
Piston Area
Viscous Damping (estimated)
Oil Volume Between Piston and Valve

Ap,e,L
Bp,e,L
Vt,L

1.347· 10−3 m2
5500 N s/m
0.001 m3

Rudder Cylinders
Internal Leakage Coefficient
Piston Area
Stroke

Cip,r,L
Ap,r,L
Sp,r,L

1· 10−12
2.1· 10−3 m2
0.5 m

Me
Je
LM,e
ae,AC
be,AC
ce,AC
de,AC
ae,LS

40 kg
3.79kgm2
100 mm
-10 mm
85 mm
0
450 mm
-10 mm

Mechanical Model
Elevators
Mass
Moment of Inertia
Level Arm to Center of Mass
Airplane Cylinders Distance a
Airplane Cylinders Distance b
Airplane Cylinders Distance c
Airplane Cylinders Distance d
Load Cylinders Distance a
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Load Cylinders Distance b
Load Cylinders Distance c
Load Cylinders Distance d

be,LS
ce,LS
de,LS

170 mm
170 mm
650 mm

Rudder
Mass
Moment of Inertia
Airplane Cylinders Distance
Airplane Cylinders Distance
Airplane Cylinders Distance
Airplane Cylinders Distance
Load Cylinders Distance a
Load Cylinders Distance b
Load Cylinders Distance c
Load Cylinders Distance d

Mr
Jr
ar,AC
br,AC
cr,AC
dr,AC
ar,LS
br,LS
cr,LS
dr,LS

55 kg
9kgm2
40 mm
80 mm
270 mm
390 mm
240 mm
200 mm
950 mm
360 mm

a
b
c
d
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B

List of Components

Hydraulic Equipment, Aircraft System
Servo Actuators, Elevators
Manufacturer:
Dowty Aerospace
Model Number:
7U7852
Serial Number:
0004, 0005, 0006, 0009
Position:
In front of each elevator
Servo Actuator, Rudder
Manufacturer:
Dowty Aerospace
Model Number:
7U7745
Serial Number:
0005A, 0066T
Position:
In front of the rudder
Accumulator
Manufacturer:
Model Number:
Serial Number:
Position:

York Industries
08-8423-001-1
8423-8586, 8423-7870
Below the rig, at the aircraft system supply pipes

Servo Valve
Manufacturer:
Model Number:
Serial Number:
Position:

MOOG
7852-419
0001, 0002, 0003, 0005, 0012, 0052
Directly connected to each servo actuator

Bypass Valve
Manufacturer:
Model Number:
Serial Number:
Position:

Unknown
Directly connected to each servo actuator

Constant Pressure Pump
Manufacturer:
Abex Aerohydraul
Model Number:
AP1VC-05-03
Serial Number:
CO32, FE37
Position:
In the basement of the laboratory
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Hydraulic Equipment, Load Simulation System
Servo Actuators
Manufacturer:
Model Number:
Serial Number:
Position:

Rexroth Mecman
207 MT4
In front of and bellow the elevators,
and at the right side of the rudder

Servo Valve, Elevators
Manufacturer:
Model Number:
Serial Number:
Position:

MOOG
E760-557
E102, E103
Above the attachment of the actuators

Servo Valve, Rudder
Manufacturer:
Model Number:
Serial Number:
Position:

MOOG
E760-559
E105
Next to the actuator

Bypass Valve
Manufacturer:
Model Number:
Serial Number:
Position:

MOOG
E504-024
E121, E125, E126
Directly connected to each servo valve

Unequal Area Relief Module
Manufacturer:
MOOG
Model Number:
E506-210
Serial Number:
E221, E225, E228
Position:
Directly connected to each servo valve
Constant Pressure Pumps
Manufacturer:
Unknown
Model Number:
Serial Number:
Position:
In the basement of the laboratory
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Force Gauges
Rudder & Elevators
Manufacturer:
Model Number:
Serial Number:
Output:
Range:
Position:

Revere Transducers Inc.
363-5K-D3-20P1
AZ0958, CT0626, DT0641
3 mV/V at 5 K
0-5000 lbs
At the piston rod of the load simulation cylinders

Angle Sensors
Left Elevator
Manufacturer:
Model Number:
Serial Number:
Position:

BI Mexico
Directly attached to the elevator, next to the servo actuators

Right Elevator & Rudder
Manufacturer:
Schaevitz
Model Number:
R30D
Serial Number:
9726 AFQEE, 9631 AJUAY
Range:
± 27°
Output:
± 3.37 V (125 mV/°)
Position:
Directly attached to the elevator, next to the servo actuators
Rudder
Manufacturer:
Model Number:
Serial Number:
Range:
Output:
Position:

Schaevitz
R30D
9631 AJUAY
± 20°
± 2.5 V (125 mV/°)
Directly attached to the rudder, next to the servo actuators
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Pressure Gauges
Rudder
Manufacturer:
Model Number:
Serial Number:
Range:
Position:

Paine
210-30-110-09
158075
0-5000 PSIS
At the high pressure side of the servo valve
for the right aircraft actuator

Manufacturer:
Model Number:
Serial Number:
Range:
Position:

Paine
210-30-110-09
165677
0-5000 PSIS
At the high pressure side of the servo valve
for the left aircraft actuator

Manufacturer:
Model Number:
Serial Number:
Range:
Position:

Paine
210-30-110-04
146452
0-2000 PSIS
At the low pressure side of the servo valve
for the right aircraft actuator

Manufacturer:
Model Number:
Serial Number:
Range:
Position:

Paine
210-30-110-04
146450
0-2000 PSIS
At the low pressure side of the servo valve
for the left aircraft actuator

Right Elevator
Manufacturer:
Model Number:
Serial Number:
Range:
Position:

Manufacturer:

Paine
210-30-110-09
146439
0-5000 PSIS
At the high pressure side of the servo valve
for the left aircraft actuator
Paine
A-7

Model Number:
Serial Number:
Range:
Position:

210-30-110-09
165075
0-5000 PSIS
At the low pressure side of the servo valve
for the left aircraft actuator

Aircraft Pump System 1, Suction Line
Manufacturer:
Paine
Model Number:
210-30-110-04
Serial Number:
146445
Range:
0-2000 PSIS
Position:
Directly connected to the suction line
Aircraft Pump System 1, System Pressure
Manufacturer:
Paine
Model Number:
210-30-110-09
Serial Number:
146407
Range:
0-5000 PSIS
Position:
Directly connected to the system pressure line
Aircraft Pump System 1, Pump Leakage
Manufacturer:
Paine
Model Number:
210-30-110-01
Serial Number:
160042
Range:
0-500 PSIS
Position:
Directly connected to the leakage line
Aircraft Pump System 2, System Pressure
Manufacturer:
Paine
Model Number:
210-30-110-09
Serial Number:
146409
Range:
0-5000 PSIS
Position:
Directly connected to the system pressure line
Aircraft Pump System 2, Pump Leakage
Manufacturer:
Paine
Model Number:
210-30-110-04
Serial Number:
154733
Range:
0-2000 PSIS
Position:
Directly connected to the leakage line
A-8

Flow Meters
Pump System 1, Pump Leakage
Manufacturer:
Flow Technology
Model Number:
FT4-8AENS-LEA-1
Serial Number:
84 010 000
Range:
0.95-9.5 l/min
Position:
Directly connected to the leakage line
Left Elevator Aircraft Actuator, Return Flow
Manufacturer:
Flow Technology
Model Number:
FT8-8AENS-LEA-1
Serial Number:
806 091
Range
2.8-28 l/min
Position:
Directly connected to the return line from the
rightmost of the actuators
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C

Derivations for Hopsan model

For the hydraulic cylinders, the level arm expressions can be derived by
introducing four lengths in the geometry, see figure 27.

Figure 27: The attachment of a rudder with its actuators. The geometry
can be described by four measurable lengths.
From these four lengths, a triangle between the cylinder attachments and
the rotational axis of the rudder can be defined, see figure 28. From this,
an equation for the level arm as a function of c, d and β can be defined.
p
L = c2 + d2 sin β
(C.2)
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Figure 28: The triangle between the attachment points of the actuator and
the rotation axis of the rudder.
The angle β can now be derived from the law of cosines:
p
p
p
( a2 + b2 )2 − ( c2 + d2 )2 − (x0 + x)2 = −2 c2 + d2 (x0 + x)cosβ (C.3)

β = arccos (

a2 + b2 − c2 − d2 − (x0 + x)2
√
)
−2 c2 + d2 (x0 + x)

(C.4)

Equation (C.2) and (C.4) then yields the final equation for the level arm as
a function of x.

L=

p
a2 + b2 − c2 − d2 − (x0 + x)2
√
))
c2 + d2 sin (arccos (
−2 c2 + d2 (x0 + x)

(C.5)

Because all x can be described as functions of θ, it is preferable to use θ as
the state variable. The required equations can be obtained by introducing
a new triangle with distances e and f , see figure 29.

A-11

Figure 29: The right-angled d-e-x-triangle will give equations for x as a
function of θ.
The lengths of e and f can be described as the initial value and the change
in position from this value. That gives equation (C.6) and (C.7), see figure
30.
e = e0 + ∆e

(C.6)

f = f0 + ∆f

(C.7)

Figure 30: The actual position can be described as initial value plus the
change in position from the initial value.
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Because x describes the change in length of the hypotenuse, it can be expressed as the difference between the actual length and the initial length.

x = (x0 + x) − x0 =

q
p
(e0 + ∆e)2 + (f0 + ∆f )2 − e20 + f02

(C.8)

∆e and ∆f can be obtained from studying figure 27 and noticing the following relationships:
∆e = a sin θ + b(1 − cos θ)

(C.9)

∆f = a(cos θ − 1) + b sin θ

(C.10)

This figure also gives expressions for the initial values (θ = 0).
e0 = c − b

(C.11)

f0 = a + d

(C.12)

Equations (C.8)-(C.12) put together gives the total expression for x as a
function of a, b, c and d. After some simplifications the final expression for
the cylinder positions is derived:
x=

p
(c + a sin θ + b cos θ)2 + (d + a cos θ + b sin θ)2 −
p
(c − b)2 + (a + d)2

(C.13)

The expression for the level arm to the center of gravity on the elevators
will be as shown in equation (C.14). LG,0 is the level arm at the neutral
position (θ = 0).
LG = LG,0 cos θ
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(C.14)

D

Complete Hopsan Model

Figure 31: The system was modeled in the Hopsan simulation software.
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E

Importing External C-Code to LabVIEW

This guide will explain step-by-step how to import external C Code to LabVIEW. Most of the information is gathered from Nat, 2003a. It has been
modified to work with the following software:
- Microsoft Windows XP Service Pack 3
- Microsoft Visual C++ 2008 Express Edition
- National Instruments LabVIEW 8.6
- National Instruments NI-DAQ 8.9
1. Create a .c file with the following basic structure:
/* CIN source file */
# include " extcode . h "
MgErr CINRun ( double * Num_in_1 , double * Num_in_2 ,
double * Num_out_1 , double * Num_out_2 )
{
// Place your code here ,
// this is just an example
* Num_out_1 = * Num_in_1 + * Num_in_2 ;
* Num_out_2 = * Num_in_1 * * Num_in_2 ;
return noErr ;
}

 This example function will receive two input signals and return
their sum and product, respectively.

2. Compile the code using Visual C++
 Go to File → New → Project
 Choose Win32 Project
 Choose a project directory and give the project a name
 Click Application Settings
 Select DLL and Empty Project
 Click Finish
 Go to Project → Add Existing Item
 Browse to the correct directory and add your C file
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 Go to Project → Add Existing Item
 Browse to <your LabVIEW directory> \cintools
 Add the following files:

–
–
–
–

cin.obj
labview.lib
lvsb.lib
lvsbmain.def

 Go to Project → Properties
 Choose All Configurations in the Configurations box
 Select C/C++
 Specify the path to your cintools directory under Additional
Include Directories
 Go to C/C++ → Code Generation
 Set Struct Member Alignment to 1 byte
 Set Runtime Library to Multi-threaded DLL (/MD)
 Select the Custom Build Step tab
 Write the following on a single line in the Command Line box:

– <your cintools directory> \lvsbutil -c ”$(TargetName)” -d
”$(OutDir)”
 Write the following in the Output box:

– $(OutDir)$(TargetName).lsb
 Go to Linker → Input
 Write the following in the Module Definition File box

– <your cintools directory> \lvsbmain.def
 Click on OK to close the Properties screen
 Select Build → Build <project name>

3. A .lsb file has been created, and is ready to be imported in LabVIEW
 Open the block diagram in your virtual instrument
 Add a Code Interface Node block
 Enlarge the block so that a sufficient number of signals are visible
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 Connect the signals. Each row can only have one input signal or
one output signal.

Figure 32: A Code Interface Node block is used to execute external code in
LabVIEW.
 Right click on the block and choose Load Code Resource
 Browse to your .lsb file and import it

4. If no problems occur, your C function has been imported and is ready
for execution!
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F

Importing Shared Libraries to LabVIEW

This guide will explain step-by-step how to create a shared library file (.dll)
and import it from LabVIEW. Most of the information is gathered from
Nat, 2003a. It has been modified to work with the following software:
- Microsoft Windows XP Service Pack 3
- Microsoft Visual C++ 2008 Express Edition
- National Instruments LabVIEW 8.6
- National Instruments NI-DAQ 8.9
1. Create a .c file with the following basic structure:

/* Call Library source file */
# include " extcode . h "
_declspec ( dllexport ) long function_name ( double * in1 , double * in2 ,
double * out1 , double * out2 )
{
// Place your code here ,
// this is just an example
* out1 = * in1 + * in2 ;
* out2 = * in1 * * in2 ;
return 0;
}

 This example function will receive two input signals and return
their sum and product, respectively.

2. Compile the code using Visual C++
 Go to File → New → Project
 Choose Win32 Project
 Choose a project directory and give the project a name
 Click Application Settings
 Select DLL and Empty Project
 Click Finish
 Go to Project → Add Existing Item
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 Browse to the correct directory and add your C file
 Go to Project → Properties
 Choose All Configurations in the Configurations box
 Select C/C++
 Specify the path to your cintools directory under Additional
Include Directories
 Go to C/C++ → Code Generation
 Set Struct Member Alignment to 1 byte
 Set Runtime Library to Multi-threaded DLL (/MD)
 Click on OK to close the Properties screen
 Select Build → Build <project name>

3. A .dll file has been created, and is ready to be imported in LabVIEW
 Open the block diagram in your virtual instrument
 Add a Call Library Function block
 Double-click on the block to open the configuration window
 Browse to your .dll file in the Library name or path box
 Select your function in the Function name drop-down menu
 Go to the Parameters tab
 Rename the return type parameters to error and set its type
to Numeric
 Add the rest of your parameters in the correct order. Make sure
to use the correct names and data types. Choose Pointer to
Value under pass for all parameters.
 Check that the function call under Function prototype looks
exactly like the one in your source code.

4. You should now be able to connect and execute your code in LabVIEW.
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G

List of DLL Function Calls

If used correctly, the function calls in the Call Library Function block in
LabVIEW shall look like this.
abso.dll
int32_t abso_func(double *in, double *out);

ackum.dll
int32_t ackum_func(double
double
double
double

*p1, double *q1, double *c1, double *zc1,
*voil, double *betae, double *pmin, double *vtot,
*vgas, double *kappa, double *kce, double *e0,
*time_step, double *time);

div.dll
int32_t div2_func(double *in1, double *in2, double *out);

fcsrc.dll
int32_t fcsrc_func(double *fi, double *c, double *zc, double *time_step,
double *time);

fpump.dll
int32_t fpump_func(double
double
double
double

*p1, double *q1, double *c1, double *zc1,
*p2, double *q2, double *c2, double *zc2,
*speed, double *dp, double *kcp,
*time_step, double *time);

gain.dll
int32_t gain_func(double *in, double *out, double *k);

machine.dll
int32_t machine_func(double
double
double
double
double
double

*p1, double *q1, double *c1, double *zc1,
*p2, double *q2, double *c2, double *zc2,
*f3, double *x3, double *sx3, double *s2x3, double *c3,
*zc3, double *eps, double *betae, double *je, double *v1,
*v2, double *dp, double *cim, double *bm,
*time_step, double *time);

mkload.dll
int32_t mkload_func(double
double
double
double

*f1, double
*f2, double
*ml, double
*time_step,

*x1, double *sx1, double *s2x1, double *c1, double *zc1,
*x2, double *sx2, double *s2x2, double *c2, double *zc2,
*bl, double *kl, double *xmin, double *xmax,
double *time);
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mload.dll
int32_t mload_func(double
double
double
double

*f1, double
*f2, double
*ml, double
*time_step,

*x1, double *sx1, double *s2x1, double *c1, double *zc1,
*x2, double *sx2, double *s2x2, double *c2, double *zc2,
*bl, double *xmin, double *xmax,
double *time);

mload4.dll
int32_t mload4_func(double
double
double
double
double
double

*f1, double
*f2, double
*f3, double
*f4, double
*ml, double
*time_step,

*x1, double *sx1, double *s2x1, double
*x2, double *sx2, double *s2x2, double
*x3, double *sx3, double *s2x3, double
*x4, double *sx4, double *s2x4, double
*bl, double *xmin, double *xmax,
double *time);

*c1,
*c2,
*c3,
*c4,

double
double
double
double

*zc1,
*zc2,
*zc3,
*zc4,

*f1, double
*f2, double
*ml, double
*time_step,

*x1, double *sx1, double *s2x1, double *c1, double *zc1,
*x2, double *sx2, double *s2x2, double *c2, double *zc2,
*bl, double *fc, double *xmin, double *xmax,
double *time);

*p1, double
*p2, double
*f3, double
*jl, double
*time_step,

*q1, double *c1, double *zc1,
*q2, double *c2, double *zc2,
*x3, double *sx3, double *s2x3, double *c3, double *zc3,
*bl, double *eps, double *dp, double *cim, double *bm,
double *time);

mloadc.dll
int32_t mloadc_func(double
double
double
double

motorj.dll
int32_t motorj_func(double
double
double
double
double

mrudder.dll
int32_t mrudder_func(double
double
double
double
double
double
double
double
double
double
double

*f1, double *c1, double *zc1,
*f2, double *c2, double *zc2,
*f3, double *c3, double *zc3,
*the, double *sthe, double *l1, double *l2, double *l3,
*ml, double *igl, double *bl, double *kl, double *lg,
*a1, double *b1, double *se1, double *d1,
*a2, double *b2, double *se2, double *d2,
*a3, double *b3, double *se3, double *d3,
*themin, double *themax, double *x1min, double *x1max,
*x2min, double *x2max, double *x3min, double *x3max,
*time_step, double *time);

mult2.dll
int32_t mult2_func(double *in1, double *in2, double *out);

ocv.dll
int32_t ocv_func(double
double
double
double
double

*p1,
*p2,
*p3,
*x0,
*ph,

double
double
double
double
double

*q1, double *c1, double *zc1,
*q2, double *c2, double *zc2,
*q3, double *c3, double *zc3,
*pref, double *tao, double *kcs, double *kcf, double *qnom,
*kappa, double *time_step, double *time);
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pcsrc.dll
int32_t pcsrc_func(double *pi, double *c, double *zc, double *time_step, double *time);

pids.dll
int32_t pid_func(double *out, double *yref, double *y, double *k, double *wi, double *td,
double *ymin, double *ymax, double *time_step, double *time)

pistm1.dll
int32_t pistm1_func(double
double
double
double
double

*p1, double *q1, double *c1, double *zc1,
*p2, double *q2, double *c2, double *zc2,
*f3, double *x3, double *sx3, double *s2x3, double *c3, double *zc3,
*ml, double *bl, double *kl, double *a1, double *a2, double *sl,
*cip, double *bp, double *time_step, double *time);

piston.dll
int32_t piston_func(double
double
double
double
double
double

*p1, double *q1, double *c1, double *zc1,
*p2, double *q2, double *c2, double *zc2,
*f3, double *x3, double *sx3, double *s2x3, double *c3, double *zc3,
*betae, double *me, double *v01, double *v02, double *a1,
*a2, double *sl, double *cip, double *bp,
*time_step, double *time);

ppump.dll
int32_t ppump_func(double
double
double
double
double
double

*p1, double *q1, double *c1, double *zc1,
*p2, double *q2, double *c2, double *zc2,
*p3, double *q3, double *c3, double *zc3,
*z, double *vz, double *pdif, double *speed, double *qmin,
*qmax, double *taov, double *lp, double *rp, double *tp,
*tm, double *wp1, double *kcp, double *time_step, double *time);

preg.dll
int32_t preg_func(double
double
double
double
double

*p1, double *q1, double *c1, double *zc1,
*p2, double *q2, double *c2, double *zc2,
*p3, double *q3, double *c3, double *zc3,
*x0, double *pref, double *tao, double *kcs, double *kcf,
*qnom, double *ph, double *time_step, double *time)

prv.dll
int32_t prv_func(double
double
double
double

*p1,
*p2,
*x0,
*ph,

double
double
double
double

*q1, double *c1, double *zc1,
*q2, double *c2, double *zc2,
*pref, double *tao, double *kcs, double *kcf, double *qnom,
*time_step, double *time);

psrc.dll
int32_t psrc_func(double *pi, double *p, double *q, double *c, double *zc,
double *time_step, double *time);
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pvalv.dll
int32_t pvalv_func(double
double
double
double
double
double

*p1, double *q1, double *c1, double *zc1,
*p2, double *q2, double *c2, double *zc2,
*p_open, double *q_open, double *c_open, double *zc_open,
*p_close, double *q_close, double *c_close, double *zc_close,
*x0, double *pref, double *tao, double *kcs,
*kcf, double *qnom, double *ph, double *time_step, double *time)

serval.dll
int32_t serval_func(double
double
double
double
double
double
double

*p_p, double *q_p, double *c_p, double *zc_p,
*p_t, double *q_t, double *c_t, double *zc_t,
*p_a, double *q_a, double *c_a, double *zc_a,
*p_b, double *q_b, double *c_b, double *zc_b,
*xv, double *xvr, double *rho, double *cq, double *sd,
*frac, double *xul, double *xvmax, double *wv, double *dvint,
*time_step, double *time);

spring.dll
int32_t spring_func(double *x1, double *sx1, double *c1, double *zc1,
double *x2, double *sx2, double *c2, double *zc2,
double *k, double *x0, double *time_step, double *time);

sub2.dll
int32_t sub2_func(double *in1, double *in2, double *out);

sum2.dll
int32_t sum2_func(double *in1, double *in2, double *out);

sxsrc.dll
int32_t sxsrc_func(double *sxi, double *f, double *x, double *sx, double *c, double *zc,
double *time_step, double *time);

valv33.dll
int32_t valv33_func(double
double
double
double
double
double

*p_p, double *q_p, double *c_p, double *zc_p,
*p_t, double *q_t, double *c_t, double *zc_t,
*p_a, double *q_a, double *c_a, double *zc_a,
*xv, double *rho, double *cq, double *sd, double *frap,
*frat, double *xap0, double *xat0, double *xvmax,
*time_step, double *time);

valv43.dll
int32_t valv43_func(double
double
double
double
double
double
double
double

*p_p, double *q_p, double *c_p, double *zc_p,
*p_t, double *q_t, double *c_t, double *zc_t,
*p_a, double *q_a, double *c_a, double *zc_a,
*p_b, double *q_b, double *c_b, double *zc_b,
*xv, double *rho, double *cq, double *sd,
*frap, double *frat, double *xap0, double *xat0,
*frbp, double *frbt, double *xbp0, double *xbt0,
*xvmax, double *time_step, double *time);
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volume2.dll
int32_t volume2_func(double *p1, double *q1, double *c1, double *zc1,
double *p2, double *q2, double *c2, double *zc2,
double *v, double *betae, double *time_step, double *time);

volume3.dll
int32_t volume2_func(double
double
double
double

*p1, double *q1, double *c1, double *zc1,
*p2, double *q2, double *c2, double *zc2,
*p3, double *q3, double *c3, double *zc3,
*v, double *betae, double *time_step, double *time);

volume4.dll
int32_t volume2_func(double
double
double
double
double

*p1, double *q1, double *c1, double *zc1,
*p2, double *q2, double *c2, double *zc2,
*p3, double *q3, double *c3, double *zc3,
*p4, double *q4, double *c4, double *zc4,
*v, double *betae, double *time_step, double *time);

vpump.dll
int32_t vpump_func(double
double
double
double

*p1, double *q1, double *c1, double *zc1,
*p2, double *q2, double *c2, double *zc2,
*eps, double *speed, double *dp, double *kcp,
*time_step, double *time);
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